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Introduction
This document contains pertinent information on installing, configuring, and using the Cisco Voic
Services Provisioning Tool (VSPT) Release 2.1 software. For more information on the Cisco VSP
software, please visit Cisco’s website at: http://www.cisco.com > Software Center > Voice Softwa
Voice Services Provisioning Tool or http://www.cisco.com/cgi-bin/tablebuild.pl/vspt.

This document outlines the latest information about the Cisco VSPT Release 2.1.  VSPT Releas
helps you create configuration files across multiple devices including the Cisco PGW 2200, Cisco M
Gateway for SS7 PRI Gateway and the Tandem Offload Solutions.
Corporate Headquarters:
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The Cisco VSPT can help avoid common errors that might arise if devices are provisioned
independently.  This package eliminates the need to enter duplicate data and enables you to imp
configurations to and export configurations from the PGW 2200. It also generates the configuration
you need to provision the PGW 2200—including the following provisioning information:

• Signaling

• Trunk groups

• Trunks

• Routes

• Dial plans

Software Release History
This section contains information only for the current and previous releases. For information on ea
releases, please refer to a previous version’s release notes.

Release 2.1

Version 2.1 supports the MGC Mistral release 9.1(5) software release. It allows you to:

• Show and modify the states of various MGC configuration elements, (signaling services, trun
groups, trunks, etc).

• Query the administrative and desired states for numerous MGC components.

• Send commands to take elements in and out of service.

This is helpful when deleting trunks that are in service.  From the new state management
functionality, you can take those trunks out of service from VSPT, and then issue provisionin
commands to delete them.

The following SPRs were resolved:

Release 2.0

• Tandem Offload using 5300 gateways solution

• Tandem Offload using VISM gateways solution

• Support for SS7 PRI Gateway (North America) solution

– Media Gateway: MGX 8260, Releases 1.1 and 1.2

– Media Gateway Controller Software: MGC software Release 7.4 (10)B (minimal release 
Release 7)

• Support for SS7 PRI Gateway (EMEA) solution

Table 1 Resolved Caveats for Software Release 1.6(1)

Identifier Severity Component Description

CSCdt36942 1 provision  Can't configure DS0s above 480 in E1 mode

CSCdt81092 2 provision  Cujo config with E1s imported as T1s

CSCdt81543 2 other  "more" button not working when adding trunks.
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– Media Gateway: MGX 8260, Releases 1.1 and 1.2

– Media Gateway Controller software: MGC software Release 7.4(10)B (minimal release fo
Release 7)

• SS7 Interconnect for Access Servers

• SS7 Interconnect for Voice Gateways

• Support for Billing and Measurement Server (BAMS) configuration

BAMS Phase II, Release 2.62 and above

Release 1.5(4) Level 01

The following SPR was resolved:

The following issue was resolved:

Updated the configEditor.properties file to specify additional SS7 signaling path MDO dialect

Release 1.5

• Support for SS7 PRI Gateway solution configuration

Media Gateway: MGX 8260, Releases 1.1 and 1.2

• Support for SS7 PRI Gateway solution configuration

Media Gateway Controller software: MGC software Release 7.4(10)B (minimal release for
Release 7)

• Support for Billing and Measurement Server (BAMS) configuration

BAMS Phase II, Release 2.62 and above

Release 1.1.2

This release corrected the MGX 8260 commands required for MGCP connections.

Version 1.1

• Initial release

• Support for SS7 PRI Gateway solution configuration

Media Gateway: MGX 8260, Release 1.1.1

• Support for Tandem Transit solution configuration

Media Gateway: MGX 8850/VISM cards, Release 2.0.1

• Support for PGW 2200, Release 7.4(8)C

Table 2 Resolved Caveats for Software Release 1.5(4) Level 01

Identifier Severity Component Description

CSCdt36493 2 bams VSPT 1.5 does not import SS7 sigpath from SC2200 into
BAMS
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System Requirements
The following is the minimum hardware you need to run the Cisco VSPT software:

• Sun Ultra-5 Workstation (333 MHz or faster)

• Sun Solaris 2.6 (Cisco VSPT 2.1 does not work with Solaris 2.7 or greater)

– May 1998 release recommended

– Openwindows with the Common Desktop Environment (CDE)

– Latest Solaris 2.6 recommend patch set (http://sunsolve.sun.com; clickPatches)

• 8-bit video graphics card

• 128 MB of System RAM

• 128 MB of free disk space (in installation directory)

• 128 MB of free swap space

• Approximately 4 MB of disk space in the /var partition required for each installation session

Supported Network Elements
The following network elements have been tested and verified to work with this release of the
Cisco VSPT.

Note All other versions of network element software have not been tested and are *not* supported wit
this version.

• Cisco Media Gateway (MGX):

– MGX8260: 1.1 or SCC_r01.01.a04 as reported by version command and 1.2

– MGX8850: Voice Interworking Service Module (VISM) Release 2.0.1

• Cisco VSPT software (releases as specified in Table 1):

• Cisco BAMS Phase II, Release 2.62 and above

Caveats
Contact your Cisco representative to obtain status on problem reports. Caveats are sorted by se
then identifier, then component. Only severity 1, 2, and 3 caveats are listed.

Table 3 Supported VSPT Software Releases

VSPT Release Minimum Requirement for MGC Release 7

1.5(1) 7.4(10)B

1.5(2) 7.4(10)B

1.5(3) 7.4(11)
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There are no open caveats for VSPT 2.1.

Table 4 Resolved Caveats

Identifier Severity Component Description

CSCdt86681 1 other MGC version 9.0.2 is less than minimum version 9.0(1)
error.

CSCdt35632 2 other Deleting SessionSet did not remove corresponding IpFa
and D-Chan.

CSCdt95428 2 other Dropdown list for DS1 number incorrect in append trunks
pane.

CSCdt50530 3 other SessionSet: peerAddr2 after import.

CSCdt60844 3 provision VSPT does not check VISM line type installed.

CSCdt60864 3 provision Cannot provision required VISM parameters in VSPT.

CSCds55590 3 other Need to check assignment of path before delete.

CSCdt34576 3 other ACC: MCL threshold only supported by prov-ed.

CSCdt52148 3 other Import dat file from VSC incorrect.

CSCdt66880 3 provision Cannot deploy a TG profile without any properties.

CSCdt67781 3 provision Can modify service name when a result is connected to 

CSCdt30492 3 other Launching VSPT failes if Java Home env variable set.

CSCdt60881 3 provision VSPT does not set ISDN lapd type in VISM.

CSCdt60894 3 provision VSPT sends incorrect session parameters to VISM.

CSCdt69742 3 provision Redundancy for VISM is not allowed in VSPT.

CSCdt88046 3 other VISM against Indiana: no or yes expected after cnflnsig.

CSCdt88811 3 other VISM: Error getting casInfo from traffic part.

CSCdt88979 3 other VISM: Delete ipfas causes deployment error.

CSCdt90133 3 other VISM: Decrease number of T1 causes deployment error.

CSCdt90621 3 other Adding trunks to multiple visms: unnecessary warning
window

CSCdt97566 3 other Unable to append trunks on AS5000

CSCdu00357 3 other trkGrp incremental: property missed

CSCuk22199 3 other PB: Dart will not import from 9.0.2 VSC

CSCuk22331 3 provision Clicking more on trunk addition screen prevents trunk
addition
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Known Issues and Operational Recommendations

Using the Cisco AS5x00 as a Media Gateway
If you use Cisco AS5x00 as media gateways, you must update the DEFDS1TYPE flag to either E1
(in the configEditor.properties) based on the type of card used in the AS5x00 devices.

MGCP endpoint names for IOS devices do not indicate either T1 or E1 endpoints.  When importi
configuration from the MGC, this property setting is used to inform VSPT of which type of cards ar
use on the AS5x00 device.

<VSPT_INSTALL_DIR>/classes/com/cisco/transpath/dart/editor

Note To obtain the VSPT_INSTALL_DIR enter the following command:
pkgparam _DART_PKG_NAME_ BASEDIR

Determining a Set of Incremental Commands to be Deployed
When determining a set of incremental commands to be deployed, VSPT makes a best-attempt 
incremental commands. However, some operations are not supported by the MGC. In those insta
is recommended that you visually inspect the commands to be deployed and modify them accordi
Also, you have the ability to cancel the deployment and redeploy as a New config.

Performing an Incremental Deployment
When performing an incremental deployment, the user can specify the based on config as [LAST
UPDATE].  This computes a set of incremental commands against the last config that was impor

This is a useful mechanism when you want to import from an MGC, make a series of modifications,
then redeploy the changes only.  To accomplish this, use [LAST UPDATE] as the config to compa
against.

Customizable Properties
VSPT has startup properties that can be modified to customize the behavior of the application.  T
property file is named configEditor.properties, and is located in the
//classes/com/cisco/transpath/dart/editor directory.

The following items should be noted:

• Minimum required MGC version for operation: MinMgcVersion.elan=7.4(10)

• When VSPT attempts to deploy to the MGC, it tries to obtain a provisioning session.  If the
provisioning session is in use, VSPT deployment waits, then retries to deploy to the MGC.  T
following values indicate the number of retry attempts, and wait time in seconds.

Deploy.Retry=3
Deploy.WaitPOM=45
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• When adding trunks to the configuration, VSPT checks to ensure that appropriate resources
added to the media gateway, (NAS, MGX-8260, VISM card, etc).  If the resoures do not exis
trunks are not added.  To disable this check, use the property value:

MGW_RES_CHECK=false

• Default values for graphical screens can be specified using values in the properties file.

• VSPT uses MML commands to activate and synchronize configurations with a standby MGC
During periods of high network usage, the MGC’s prov-dply and prov-sync commands can fail w
an error stating:

mml> prov-dply
MGC-01 - Media Gateway Controller 2001-04-10 18 ;40 ;43
M DENY
SROF
“PROV-DPLY: error transferring data files”
/* Status, Requested Operation Failed on the component */
;

If this occurs, retry the operation from VSPT by activating the MGC Viewer located under the To
menu option.

When the list of configurations is shown, select the name of the configuration that you created.
select Configuration > Activate to retry activating the configuration. You can also perform a
Configuration > Synchronize to request that the MGC synchronize its configuration with its stan
MGC.

DialPlan Configuration Creation and Maintenance
To make the creation and maintenance of configurations easier, VSPT allows you to enter range
for A/B digtree tables.

The implementation of this feature in VSPT is structured to accommodate overdecadic numberin
well as ordinary numbering. If you wish to enter multiple ranges, you can use commas to separa
entries.

Some examples of range input for A/B digtree tables follow:

To create digitstring entries from 300 to 399, you can enter:

3[0-9][0-9]

If you input:

1234ff,234[0-8],89[0-7]5[6-f]

VSPT generates digitstring entries for the numbers:

1234ff

2340, 2341, ..., 2348
89056, 89057, ..., 8905f,  89156, 89157 ... 8975f

Note # and * are not considered part of a range; if either is specified in a range input, for example, [*-9]
an error is returned.
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Screening File Creation
You can create screening files within VSPT. To create a screening file, do the following:

Step 1 From the main window, clickNumber Analysis.

Step 2 Add a dialplan and expand it.

Step 3 Click theScreening tree node.

Step 4 On the right hand side of the window, choose a screening file type.

Step 5 In the File name text field, enter a new file name.

Step 6 Click Add.

A new tree node is created under Screening node.

Step 7 Click thenew tree node.

On the right hand side of the window, the Edit File button is enabled.

Step 8 Click theEdit File  button to open the Screen file editor window where you can add entries to the 
file. Range input is also supported to allow you to input multiple numbers at one time.

Dial Plan Changes
To ease the provisioning and incremental changes for screening numbers, a new Screening Edit
is added to this version. You launch it from the menu bar Tool > Screening Editor. This tool allows
to:

• Add, modify, and delete A/B/White/Black screening numbers using the GUI. For example, to
remove screening numbers from the VSC, do the following:

Step 1 Launch the Screening Editor tool (Tool > Screening Editor).

Step 2 At the VSC, clickCommand > Rtrv #s.

The screening numbers are retrieved from the VSC.

Step 3 Highlight the number(s) that you want to remove.

Step 4 Click Edit  > Set selected #s to Delete.

Step 5 Click Command > Send selected.

• Import screening numbers from the VSC for an active configuration. You can save the screen
numbers to files, and read them back in using the menu items in the File menu. All or a subset o
screening numbers created in the GUI can be deployed to the VSC. Using the VSPT main win
you specify which VSC is used to provision screening numbers.
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Multiuser Provisioning
The VSC allows only one provisioning session at a time. VSPT accomplishes multiuser provisionin
placing a provisioning attempt (initiated with the Tools > Deploy menu option) on hold if a provision
session is already in progress.

After a 45 second timeout, VSPT retries the operation up to three times. Timeout and retry value
specified in the configEditor.properties file located in the directory:

/<install-dir>/classes/com/cisco/transpath/dart/editor.

To change these settings, modify the following lines:

Deploy.Retry=3
Deploy.WaitPOM=45

Disabling the Resource Check

When you add trunks to a configuration, VSPT checks to ensure that appropriate resources have
added to the media gateway (NAS, MGX-8260, VISM card, etc).  If the resources do not exist, V
does not allow the trunks to be added.

You may want to disable this feature if you are making frequent changes to trunk information and d
want to take the time to first specify each change on the media gateway. You may also want to disa
if you are frequently importing configurations from the VSC. The VSC does not retain complete
information about media gateway resources, and so a resource check will result in the operation fa

To disable the resource check, modify the MGW_RES_CHECK flag in the configEditor.properties
located in the directory:

/<install-dir>/classes/com/cisco/transpath/dart/editor

as follows:

MGW_RES_CHECK=false

To resume resource checking, reset the flag to true.

Multiple Trunk Group Format Support
VSPT supports multiple trunk group formats. It can parse 57, 60, and 62 column trunk group files
default for this feature is 62-columns.

As a feature of provisioning, VSPT produces a flat file that contains trunk group information. The for
of the flat file has been modified to allow for support of different trunk group properties. Depending
the software release in use, you may need to indicate which format of the trunk group file should
generated.

To change the trunk group format, modify the tgTemplate property in the following directory:

<VSPT_INSTALL_DIR>/classes/com/cisco/transpath/dart/editor/configEditor.properties
9
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The value specified in tgTemplate identifies the name of the template file that specifies the trunk g
properties and their associations.

Note To determine which template is in use in a generated trunk group file, use the prov-exp MML
command to export a configuration and examine its format.

GUI Interface for Backup and Restore
VSPT provides a graphic user interface (GUI) for the following devices:

• MGC host (active configuration)

• BAMS Phase 2 (active configuration)

• BAMS Phase 3 (active configuration)

• SLT2600 (running configuration and image on flash)

• CAT5500 (configuration and image on flash)

• CAT2900XL (running configuration and image on flash)

You can create, modify, and delete backup and restore schedules on an hourly, daily, weekly
monthly basis; all the schedules are pushed onto the crontab of the Solaris system. Additionally
can trigger backup and restore operations on demand.

To launch the backup and restoreGUI:

At the VSPT main window, click on Tools > Backup and Restore.

• Because all the schedules are pushed onto the crontab, you cannot view or modify schedules c
by a user with a different login. VSPT only allows one dedicated UNIX login to launch the Back
and Restore GUI. You are prompted for this login at installation. You can modify the dedicate
UNIX login in configEditor.properties file under:

Backup.unixID=

• Login, password, and enable password of all devices are encrypted in the crontab file.

• To provide status of each backup and restore operation, VSPT generates status logs for you
review. If an operation is triggered on demand, status is shown after the operation. If an oper
is triggered by cron, status is appended to the log file associated to the schedule ID. You can
the log file by highlighting a schedule entry in the add/view schedule table, and clicking the s
status button.

• You can also acknowledge the log file to save disk space.  Status file consists of operation tim
successful/fail(with failure reason), file name on TFTP server(if backup), directory of config fi
(if restore for MGC and BAMS), image file name(if restore image for SLT, Cat5500, or Cat2900X
For verbose log, the status log contains step-by-step commands issued by VSPT and system
feedback from the device.

Table 5 tgTemplate Values

For a trunk group file with: tgTemplate should be:

57 column format 901057

60 column format 902060

62 column format 903062
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To reduce errors when entering information in the <filename> text field, the add/modify sched
GUI hasselect/view files on TFTPandselect/view images on flashbuttons. You can use these button
or type in a filename.

New Features and Enhancements

Redirecting Number and Original Called Number
VSPT support to provision redirecting number and original called number on the MGC. To provide
minimal support, an addition of a switch or flag added to the software allows the passing of the Orig
Called Number (OCN) or the Redirecting Number to the Redirecting Number field in the NI2+ proto
The following outlines the logic for passing the appropriate field to the Redirecting Number in the N
field:

If flag is true:

If flag is false:

Adding and Removing A Numbers from Screening Database Without Opening a
Provisioning Session

This tool, launched by selecting the Screening Editor from the Tool menu, allows you to
Add/Modify/Delete A/B/White/Black screening numbers through the GUI. You can save the creat
numbers to files and read them back in by clicking the menu items in the File menu. All or a subs
screening numbers can be deployed to VSC without occupying a provisioning session, for example
do not need to do a Prov-sta::srcver or prov-stp. The VSC to which you are provisioning screenin
numbers is the one you specified in the VSPT main window. This tool also allows you to import
screening numbers from the VSC.

Table 6 Redirecting Number and Original Called Number Mappings for Flag is True

Fields Present in Incoming Message

OCN & Redirecting Map OCN to Redirecting Number

OCN only Map OCN to Redirecting Number

Redirecting only Map Redirecting to Redirecting Number

Table 7 Redirecting Number and Original Called Number Mappings for Flag is False

Fields Present in Incoming Message

OCN & Redirecting Map Redirecting to Redirecting Number

OCN only Map OCN to Redirecting Number

Redirecting only Map Redirecting to Redirecting Number
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Result Types Enhancements
This enhancement involves opening up result types which were allowed only under A or B analys
both A and B analysis areas.

Modification of digits and number A results for A and B number analysis should be a possible result
during analysis of the opposite number. Preanalysis also was enhanced. This allows the user to 
certain result types for A and B numbers, during analysis of the opposite number, depending on ce
conditions.

Provisioning and Operating Capability to return to Number Analysis from Cause
Analysis.

This enhancement enables allows you to modify the B-number from cause analysis, and then en
number analysis with the modified B-number.

Call Cut-off Timer
This enhancement starts a global timer, after answer for every call, and runs for a pre-configured
When the timer expires for a call, the call is released in both directions. The timer can be set on a sy
wide basis, or can be set using a result type with a timer value, in number analysis. The timer ca
configured for a minimum of 1 hour and maximum of 48 hours. This feature is common in TDM switc
to remove fraud due to long calls, which exceed credit rating, for example, with prepaid services

Support for Redundant IP Connectivity Between the MGC and MGs With a
Single IP Address

To support IP routing enhancement, two parameters, next hop address and subnet mask addres
added to the C7IPLNKs, IPLNKs, IPSESSIONs, and SS7SGIPLNKs objects.

• Next hop address—IP address or hostname of the next hop (router)

• Subnet mask—Network mask, in IP address format, used to derive the subnet address of the r
host.

To support redundancy for MG with one IP address, such as the VISM, the ability to configure mult
routes to the same destination has been added.  VSPT now supports this feature on the MGC.

Additional Option for ITU CIC Selection Method for European Interconnect
Compliance

This feature is used in some European countries where ITU-T Method 2 is employed on the intercon
Specifically this is required in Denmark for interconnect with Most Idle/Least Idle selection on tw
separate groups (even and odd CICs). VSPT now supports this feature on the MGC. This feature
supported on the MGC in 9.1(5).
12
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Multiple Dial Plans Support
This feature allows the MGC (in both VSC & SC2200 configurations) to support multiple dialplan
More specifically, this means supporting the ability to be able to move from one dial plan to anot
VSPT does support import and export of the VSC supporting this feature, however, VSPT will not f
support this until 2.1(2).

Advice of Charge
This requirement describes the Advice of charge capabilities required for deployment of the VSC
signalling controller into the German marketplace. The German specifications are derived from E
standard (reference [4]) and on this basis, the functionality introduced is expected to meet other
European marketplace requirements for this service.

The requirement can be separated into the following two parts:

• The transit of advice of charging information through the VSC where ingress and egress are
ISUP variants that support the APM message (which is used to convey AOC information).

• The VSC acts as a charge determination point, calculating the tariff required and invoking AOC
the construction and transmission of APM messages back to the ingress switch and the treatm
the associated responses.

Troubleshooting
• The X-Windows DISPLAY environment variable must be set in order for you to install the Cis

VSPT:

During installation, the X-Windows DISPLAY environment variable must be set properly. If th
variable is not set properly, the installation program exits with a Java error message or simpl
appears to stop responding.  Use the following examples to set your X-Windows DISPLAY
environment variable. Replace the value <hostname> with your machine’s hostname:

In csh or tcsh:

setenv DISPLAY <hostname>:0

In sh or ksh:

DISPLAY=<hostname>:0 ; export $DISPLAY

• If you experience problems or errors deploying to or communicating with a remote machine, c
the following points:

– Ensure that the machine is alive and responding to theping command.

– Ensure that correct login/passwords have been specified.

• If you experience errors when deploying to the PGW 2200, check the following:

– The PGW 2200 supports only one provisioning session at a time. When deploying to the P
2200, ensure that no other provisioning sessions are active.

– When activating a configuration on the PGW 2200, the PGW 2200 might require that som
signaling components are taken out of service before the configuration is activated. If yo
not take the component out of service, you receive an MML error message. You can take
component out of service from MML manually, and after that you can activate the configura
13
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• Enter the following command to determine where Cisco VSPT is installed:

/usr/bin/pkgparam _DART_PKG_NAME_ BASEDIR

• CSCOvsp stores configuration files in the /var/<install directory>/data directory.  Each
_DART_PKG_NAME_ configuration is stored in a separate directory; the directory nameis the s
as the configuration name.

In the examples below, the assumption is that CSCOvsp16 was installed in the directory
/opt/CSCOvsp16, thus = /opt/CSCOvsp16

– To rename a configuration, simply rename the directory under
/var/opt/_DART_PKG_NAME_/data

– To remove a configuration, remove the directory under /var/opt/_DART_PKG_NAME_/da

• To determine where the data directory is located, search for DartStoreDir in the
configEditor.properties file:

/usr/bin/grep DartStoreDir
/opt/_DART_PKG_NAME_/classes/com/cisco/transpath/dart/editor/configEditor.properties

Note As a safety precaution, the deinstallation procedure does not remove configuration data.  The da
must be removed manually.

Obtaining Documentation
The following sections explain how to obtain documentation from Cisco Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at the following U

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM
package, which is shipped with your product. The Documentation CD-ROM is updated monthly and
be more current than printed documentation. The CD-ROM package is available as a single unit
through an annual subscription.
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Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco product documentation from the Networ
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through the online Subscr
Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local account representa
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, elsewhere in Nor
America, by calling 800 553-NETS (6387).

Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can submit technical comme
electronically. ClickLeave Feedbackat the bottom of the Cisco Documentation home page. After yo
complete the form, print it out and fax it to Cisco at 408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your docume
write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partner
obtain documentation, troubleshooting tips, and sample configurations from online tools by using
Cisco Technical Assistance Center (TAC) Web Site. Cisco.com registered users have complete ac
the technical support resources on the Cisco TAC Web Site.

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate,
access to Cisco information, networking solutions, services, programs, and resources at any time
anywhere in the world.

Cisco.com is a highly integrated Internet application and a powerful, easy-to-use tool that provid
broad range of features and services to help you to

• Streamline business processes and improve productivity

• Resolve technical issues with online support
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• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and service. To access Cisco
go to the following URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product,
technology, or solution. Two types of support are available through the Cisco TAC: the Cisco TAC
Web Site and the Cisco TAC Escalation Center.

Inquiries to Cisco TAC are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabiliti
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticea
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspe
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operati
will occur if service is not restored quickly. No workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem and the conditions
service contracts, when applicable.

Cisco TAC Web Site

The Cisco TAC Web Site allows you to resolve P3 and P4 issues yourself, saving both cost and time. The
site provides around-the-clock access to online tools, knowledge bases, and software. To access
Cisco TAC Web Site, go to the following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contract have complete acc
the technical support resources on the Cisco TAC Web Site. The Cisco TAC Web Site requires a
Cisco.com login ID and password. If you have a valid service contract but do not have a login ID
password, go to the following URL to register:

http://www.cisco.com/register/

If you cannot resolve your technical issues by using the Cisco TAC Web Site, and you are a Cisco
registered user, you can open a case online by using the TAC Case Open tool at the following U

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cases through the Cisc
Web Site.
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Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as priority level 1 or priori
level 2; these classifications are assigned when severe network degradation significantly impacts
business operations. When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisc
engineer will automatically open a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to the followi
URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the level of Cisco su
services to which your company is entitled; for example, SMARTnet, SMARTnet Onsite, or Netw
Supported Accounts (NSA). In addition, please have available your service agreement number an
product serial number.

AccessPath, AtmDirector, Browse with Me, CCIP, CCSI, CD-PAC,CiscoLink, the CiscoPowered Network logo, Cisco Systems Networking
Academy, the Cisco Systems Networking Academy logo, Fast Step, Follow Me Browsing, FormShare, FrameShare, GigaStack, IGX, Intenet
Quotient, IP/VC, iQ Breakthrough, iQ Expertise, iQ FastTrack, the iQ Logo, iQ Net Readiness Scorecard, MGX, the Networkers logo, Packet,
RateMUX, ScriptBuilder, ScriptShare, SlideCast, SMARTnet, TransPath, Unity, Voice LAN, Wavelength Router, and WebViewer are trademarks
of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn, Discover All That’s Possible, and Empowering the Internet Gene
are service marks of Cisco Systems, Inc.; and Aironet, ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCNA, CCNP, Cisco, the Cisco Certified
Internetwork Expert logo, Cisco IOS, the Cisco IOS logo, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo,
Enterprise/Solver, EtherChannel, EtherSwitch, FastHub, FastSwitch, IOS, IP/TV, LightStream, MICA, Network Registrar, PIX, Post-Routing,
Pre-Routing, Registrar, StrataView Plus, Stratm, SwitchProbe, TeleRouter, and VCO are registered trademarks of Cisco Systems, Inc. and/or its
affiliates in the U.S. and certain other countries.

All other trademarks mentioned in this document or Web site are the property of their respective owners. The use of the word partner does n
a partnership relationship between Cisco and any other company. (0108R)
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